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1. Перечень планируемых результатов обучения по дисциплине, соотнесенных  

с планируемыми результатами освоения образовательной программы 

(с ориентацией на карты компетенций) 

 

В результате освоения образовательной программы обучающийся должен овладеть 

следующими результатами обучения по дисциплине: 

 

Результаты обучения 

Формируемая 

компетенция (с 

указанием 

кода) 

Примечание 

Знания 
Основные принципы работы в геоинформационных системах 

и различных ГИС-пакетах. 
ПК-4 

 

Умения 

Пользоваться программным обеспечением, изучаемым, на 

данном курсе, и на смежных дисциплинах, при работе с 

изображениями и картографической основой. 

ПК-4 

 

Владения 

(навыки / опыт 

деятельности) 

Навыками практической работы с геоинформационными 

пакетами в которых обрабатываются геоизображения и 

фундаментальные различия при обработке изображений в тех 

или иных ГИС. 

ПК-4 

 

 

ПК-4 - готовностью осуществлять получение оперативной гидрометеорологической 

информации и ее первичную обработку, обобщение архивных гидрометеорологических данных с 

использованием современных методов анализа и вычислительной техники. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

  



5 

 

 

2. Цель и место дисциплины  в структуре образовательной программы 

 

Дисциплина «Геоинформационные системы в гидрометеорологии» относится к 

вариативной  части.  

Дисциплина изучается на  3 курсе в 5 и 6 семестрах. 
Цель изучения дисциплины «Геоинформационные системы в гидрометеорологии», как одного из 

основных курсов в системе подготовки по направлению «Гидрометеорология», состоит в том, чтобы, дать 

возможность, изучить реальные функции и потенциальные возможности ГИС-технологий для решения 

гидрометеорологических задач, а так же рассматривает ГИС как современную компьютерную технологию 

для картирования и анализа объектов и явлений реального мира.  

Для освоения дисциплины необходимы компетенции, сформированные в рамках изучения 

следующих дисциплин: «Общая гидрология», «Метеорология и климатология»,  «Картография», 

«Общий компьютерный практикум», «Гидрология рек», «Гидрология озер и водохранилищ». 

Дисциплина «Геоинформационные системы в гидрометеорологии» призвана ознакомить 

студентов с определением геоинформационных систем, организацией баз данных в 

гидрометеорологических ИС, с обработкой гидрометеорологических данных, особенностями 

применения математического моделирования, средствами доступа к гидрометеорологическим 

данным, с современными гидрометеорологическими ИС. 

Освоение компетенций дисциплины необходимы для изучения следующих дисциплин: 

«Водно-технические изыскания», «Охрана вод суши», написания курсовых работ и выпускной 

квалификационной работы. 
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3. Содержание рабочей программы (объем дисциплины, типы и виды учебных занятий, 

учебно-методическое обеспечение самостоятельной работы обучающихся) 

 

МИНОБРНАУКИ РОССИИ 

ФГБОУ ВО «БАШКИРСКИЙ ГОСУДАРСТВЕННЫЙ УНИВЕРСИТЕТ» 

ГЕОГРАФИЧЕСКИЙ ФАКУЛЬТЕТ 

 

СОДЕРЖАНИЕ РАБОЧЕЙ ПРОГРАММЫ 

  

дисциплины «Геоинформационные системы в гидрометеорологии»  на5, 6 семестрах 

 

очная форма обучения 

 

 
Вид работы Объем дисциплины 

Общая трудоемкость дисциплины (ЗЕТ / часов) 6/216 

Учебных часов на контактную работу с преподавателем: 91,4 

лекций 46 

практических/ семинарских - 

лабораторных 44 

других (групповая, индивидуальная консультация и иные виды учебной 

деятельности, предусматривающие работу аспирантов с преподавателем) (ФКР) 
1,4 

Учебных часов на самостоятельную работу обучающихся (СР) 89,8 

Учебных часов на подготовку к экзамену/зачету/дифференцированному зачету 

(контроль) 
34,8 

  

Форма контроля: 

 

Зачет 5 семестр, экзамен 6 семестр 
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№ 

п/п 
Тема и содержание 

Форма изучения материалов: 

лекции, практические занятия, 

семинарские занятия, 

лабораторные работы, 

самостоятельная работа и 

трудоемкость (в часах) 

Основная и 

дополнитель

ная 

литература, 

рекомендуем

ая студентам 

(номера из 

списка) 

Задания по 

самостоятельной 

работе студентов  

Форма текущего 

контроля успеваемости 

(коллоквиумы, 

контрольные работы, 

компьютерные тесты и 

т.п.) 

ЛК ПР/СЕМ ЛР СР    

1 2 3 4 5 6 7 8 9 

1.  МОДУЛЬ 1.  Определение геоинформационных систем (ГИС). 

Организация баз данных в гидрометеорологических ИС. 
       

2.  Определение геоинформационных систем (ГИС). Понятие ГИС.  Их 

структура. Классификация ГИС: по назначению, по 

проблематической ориентации, по  территориальному охвату, по 

способу организации географических данных. Функциональные 

требования к ГИС: автоматизированное картографирование, 

пространственный анализ, управление данными.  Применение ГИС 

в научных исследованиях. Компьютерные технические средства и 

устройства поддержки ГИС. Программное обеспечение: системное, 

базовое и прикладное. История развития ГИС. 

4 - - - 1,2,3,4,5,6 - Контрольная работа 

3.  Общие представления о гидрометеорологической информационной 

системе: специфика гидрометеорологической информационной 

системы (ИС), задачи гидрометеорологической ИС, требования к 

техническим средствам, поддерживающим гидрометеорологические 

ИС. 

4 - - - 1,2,3,4,5,6 - Контрольная работа 

4.  Организация баз данных в гидрометеорологических ИС. 

Гидрометеорологические данные: синоптическая информация, 

аэрологические данные, океанологическая и гидрологическая 

съемки, данные спутникового мониторинга атмосферы и 

гидросферы и т.д. Ввод данных в ГИС. 

Организация баз гидрометеорологических данных: географические 

сведения, морфология, гидрометеорологическая информация. 

2 - - - 1,2,3,4,5,6 - Контрольная работа 

5.  

Изучение данных в ArcMap.  - - 2 4 1,2,3,4,5,6 
Лабораторная 

работа № 1. 

Проверка лабораторной 

работы. 

Контрольная работа 

6.  

Управление слоями карты в ArcMap. - - 2 4 1,2,3,4,5,6 
Лабораторная 

работа № 2. 

Проверка лабораторной 

работы. 

Контрольная работа 

7.  Изучение отношений объект-атрибут в ArcMap. Изучение 

преимуществ отношений объект-атрибут.  
- - 2 4 1,2,3,4,5,6 

Лабораторная 

работа № 3. 

Проверка лабораторной 

работы. 
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 Контрольная работа 

8.  

Создание компоновки карты  в ArcMap. - - 2 4 1,2,3,4,5,6 
Лабораторная 

работа № 4. 

Проверка лабораторной 

работы. 

Контрольная работа 

9.  МОДУЛЬ 2.  Обработка гидрометеорологических данных. 

Особенности применения математического моделирования в 

гидрометеорологических ИС. 

       

10.   Обработка гидрометеорологических данных. Расчет статистической 

информации. Методы восстановления гидрометеорологических 

полей: оптимальная интерполяция, метод взвешенных 

коэффициентов, сплайн-интерполяция и др. Редактирование и 

обновление базы данных (БД). Расчет дополнительных параметров 

по этим данным. 

4 - - - 1,2,3,4,5,6 - Контрольная работа 

11.  Вывод и визуализация данных. Технические средства. Методы 

визуализации данных: растровая и векторная графика. Особенности 

создания компьютерных гидрометеорологических карт и атласов. 

Отображение пространственно-временных гидрометеорологических 

характеристик. 

2 - - - 1,2,3,4,5,6 - Контрольная работа 

12.  Особенности применения математического моделирования в 

гидрометеорологических ИС. Информационное единство 

динамической модели и измерений. Адаптация модели к исходным 

данным. Мультимедийная визуализация результатов 

моделирования. Имитационное моделирование. 

2 - - - 1,2,3,4,5,6 - Контрольная работа 

13.  

Работа с надписями  в ArcMap. - - 2 4 1,2,3,4,5,6 
Лабораторная 

работа № 5. 

Проверка лабораторной 

работы. 

Контрольная работа 

14.  

Работа с проекциями в ArcMap. - - 2 4 1,2,3,4,5,6 
Лабораторная 

работа № 6. 

Проверка лабораторной 

работы. 

Контрольная работа 

15.  

Создание и документирование данных  в ArcMap. - - 2 4 1,2,3,4,5,6 
Лабораторная 

работа № 7. 

Проверка лабораторной 

работы. 

Контрольная работа 

16.  

Регистрация данных в географическом пространстве в ArcMap. - - 2 4 1,2,3,4,5,6 
Лабораторная 

работа № 8. 

Проверка лабораторной 

работы. 

Контрольная работа 

17.  

Проверка атрибутов в ArcMap. - - 2 3,8 1,2,3,4,5,6 
Лабораторная 

работа № 9. 

Проверка лабораторной 

работы. 

Контрольная работа 

18.  Всего часов: 18 - 18 35,8    
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Описание основных разделов дисциплины 

МОДУЛЬ 1.  Определение геоинформационных систем (ГИС). Организация баз данных в гидрометеорологических ИС. 

Определение геоинформационных систем (ГИС). Понятие ГИС.  Их структура. Классификация ГИС: по назначению, по проблематической 

ориентации, по  территориальному охвату, по способу организации географических данных. Функциональные требования к ГИС: автоматизированное 

картографирование, пространственный анализ, управление данными.  Применение ГИС в научных исследованиях. Компьютерные технические 

средства и устройства поддержки ГИС. Программное обеспечение: системное, базовое и прикладное. История развития ГИС. Общие представления о 

гидрометеорологической информационной системе: специфика гидрометеорологической информационной системы (ИС), задачи 

гидрометеорологической ИС, требования к техническим средствам, поддерживающим гидрометеорологические ИС. Организация баз данных в 

гидрометеорологических ИС. Гидрометеорологические данные: синоптическая информация, аэрологические данные, океанологическая и 

гидрологическая съемки, данные спутникового мониторинга атмосферы и гидросферы и т.д. Ввод данных в ГИС. Организация баз 

гидрометеорологических данных: географические сведения, морфология, гидрометеорологическая информация. 

 

МОДУЛЬ 2.  Обработка гидрометеорологических данных. Особенности применения математического моделирования в гидрометеорологических 

ИС. 

 Обработка гидрометеорологических данных. Расчет статистической информации. Методы восстановления гидрометеорологических полей: 

оптимальная интерполяция, метод взвешенных коэффициентов, сплайн-интерполяция и др. Редактирование и обновление базы данных (БД). Расчет 

дополнительных параметров по этим данным. Вывод и визуализация данных. Технические средства. Методы визуализации данных: растровая и 

векторная графика. Особенности создания компьютерных гидрометеорологических карт и атласов. Отображение пространственно-временных 

гидрометеорологических характеристик. Особенности применения математического моделирования в гидрометеорологических ИС. Информационное 

единство динамической модели и измерений. Адаптация модели к исходным данным. Мультимедийная визуализация результатов моделирования. 

Имитационное моделирование. 



10 

 

№ 

п/п 
Тема и содержание 

Форма изучения материалов: 

лекции, практические занятия, 

семинарские занятия, 

лабораторные работы, 

самостоятельная работа и 

трудоемкость (в часах) 

Основная и 

дополнительна

я литература, 

рекомендуемая 

студентам 

(номера из 

списка) 

Задания по 

самостоятельной 

работе студентов  

Форма текущего 

контроля 

успеваемости 

(коллоквиумы, 

контрольные работы, 

компьютерные тесты 

и т.п.) 
ЛК ПР/СЕМ ЛР СР 

1 2 3 4 5 6 7 8 9 

1.  МОДУЛЬ 1.  Оптимизация гидрометеорологических ИС. Средства 

доступа к гидрометеорологическим базам данных. 
       

2.  Оптимизация гидрометеорологических ИС. Критерии качества: 

простота вычислительного алгоритма, минимальная стоимость затрат 

на проведение натуральных экспериментов и т.д. 

4 - - - 1,2,3,4,5,6 - Контрольная работа 

3.  Средства доступа к гидрометеорологическим базам данных. Работа с 

гидрометеорологическими данными при помощи приложений: 

«сервера», представляющего данные из общей базы данных, и 

«клиента», запрашивающего данные у «сервера». 

4 - - - 1,2,3,4,5,6 - Контрольная работа 

4.  Приложение «сервер»: режимы функционирования, структура 

размещения ресурсов, настройки «сервера», форматы системных 

журналов, взаимосвязь между настройками «сервера» и настройками 

ядра операционной системы, организация корпоративных данных из 

БД. 

4 - - - 1,2,3,4,5,6 - Контрольная работа 

5.  Приложение «клиент»: одновременный доступ к нескольким 

серверам, одновременный доступ внутри одного «сервера» к 

нескольким базам данных. 

4 - - - 1,2,3,4,5,6 - Контрольная работа 

6.  
Определение морфометрических, ландшафтных и гидрографических 

характеристик речного водосбора. 
- - 4 8 1,2,3,4,5,6 

Лабораторная 

работа № 1. 

Проверка 

лабораторной работы. 

Контрольная работа 

7.  
Основы работы с пространственными данными (визуализация). 

Создание климатической карты мира.  
- - 4 8 1,2,3,4,5,6 

Лабораторная 

работа № 2. 

Проверка 

лабораторной работы. 

Контрольная работа 

8.  

Анализ гидрографических сетей.  - - 4 8 1,2,3,4,5,6 
Лабораторная 

работа № 3. 

Проверка 

лабораторной работы. 

Контрольная работа 

9.  МОДУЛЬ 2. Особенности гидрометеорологических ИС для Интернет. 

Обзор современных гидрометеорологических ИС. 
       

10.  Особенности гидрометеорологических ИС для Интернет. 

Возможности, предоставляемые пользователям ГИС для Интернет. 
4 - - - 1,2,3,4,5,6 - Контрольная работа 

11.  Проблемы безопасности в гидрометеорологических ИС. Контроль 

прав доступа. Контроль регистрационных журналов. Фильтрация 
4 - - - 1,2,3,4,5,6 - Контрольная работа 
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Описание основных разделов дисциплины 

МОДУЛЬ 1.  Оптимизация гидрометеорологических ИС. Средства доступа к гидрометеорологическим базам данных. 

Оптимизация гидрометеорологических ИС. Критерии качества: простота вычислительного алгоритма, минимальная стоимость затрат на 

проведение натуральных экспериментов и т.д. Средства доступа к гидрометеорологическим базам данных. Работа с гидрометеорологическими 

данными при помощи приложений: «сервера», представляющего данные из общей базы данных, и «клиента», запрашивающего данные у 

«сервера». Приложение «сервер»: режимы функционирования, структура размещения ресурсов, настройки «сервера», форматы системных 

журналов, взаимосвязь между настройками «сервера» и настройками ядра операционной системы, организация корпоративных данных из БД. 

Приложение «клиент»: одновременный доступ к нескольким серверам, одновременный доступ внутри одного «сервера» к нескольким базам 

данных. 

 

МОДУЛЬ 2. Особенности гидрометеорологических ИС для Интернет. Обзор современных гидрометеорологических ИС. 

Особенности гидрометеорологических ИС для Интернет. Возможности, предоставляемые пользователям ГИС для Интернет. Проблемы 

безопасности в гидрометеорологических ИС. Контроль прав доступа. Контроль регистрационных журналов. Фильтрация пакетов. Резервное 

копирование и восстановление данных. Шифрование данных. Обзор современных гидрометеорологических ИС. Обзор современных 

гидрометеорологических информационных систем. Основные компоненты. Приложения. Телекоммуникация. Основные принципы работы. 

Региональные гидрометеорологические ИС. 
 

пакетов. Резервное копирование и восстановление данных. 

Шифрование данных. 

12.  

Анализ цифровой модели рельефа.  - - 4 8 1,2,3,4,5,6 
Лабораторная 

работа № 4. 

Проверка 

лабораторной работы. 

Контрольная работа 

13.  

Привязка и цифрование гидрогеологической карты.  - - 4 8 1,2,3,4,5,6 
Лабораторная 

работа № 5. 

Проверка 

лабораторной работы. 

Контрольная работа 

14.  Обзор современных гидрометеорологических ИС. Обзор 

современных гидрометеорологических информационных систем. 

Основные компоненты. Приложения. Телекоммуникация. Основные 

принципы работы. Региональные гидрометеорологические ИС. 

4 - - - 1,2,3,4,5,6 - Контрольная работа 

15.  
Пространственная интерполяция характеристик годового стока с 

использованием ГИС-технологий.  
- - 4 8 1,2,3,4,5,6 

Лабораторная 

работа № 6. 

 

Проверка 

лабораторной работы. 

Контрольная работа 

16.  

Расчет характеристик годового стока на основе интерполяционных. - - 2 6 1,2,3,4,5,6 

Лабораторная 

работа № 7. 

 

Проверка 

лабораторной работы. 

Контрольная работа 

 Всего часов: 28 - 26 54    
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4. Фонд оценочных средств по дисциплине 

4.1. Перечень компетенций с указанием этапов их формирования в процессе освоения 

образовательной программы. Описание показателей и критериев оценивания компетенций 

на различных этапах их формирования, описание шкал оценивания 

 

5 семестр  

Код и формулировка компетенции: ПК-4 – готовностью осуществлять получение 

оперативной гидрометеорологической информации и ее первичную обработку, обобщение 

архивных гидрометеорологических данных с использованием современных методов анализа и 

вычислительной техники. 
Этап (уровень) 

освоения 

компетенции 

Планируемые результаты обучения 

(показатели достижения заданного уровня освоения 

компетенций) 

Критерии оценивания результатов 

обучения 

«Незачтено» «Зачтено» 

Первый этап 

(уровень) 

 

Знать: 

основные принципы работы в геоинформационных 

системах и различных ГИС-пакетах. 

Объем знаний 

оценивается на 59 

и менее баллов от 

требуемых 

Объем знаний 

оценивается от 60 до 

110 баллов от 

требуемых (включая 

10 поощрительных 

баллов) 

Второй этап 

(уровень) 

 

Уметь: 

пользоваться программным обеспечением, 

изучаемым, на данном курсе, и на смежных 

дисциплинах, при работе с изображениями и 

картографической основой. 

Объем умений 

оценивается на 59 

и менее баллов от 

требуемых 

Объем умений 

оценивается от 60 до 

110 баллов от 

требуемых (включая 

10 поощрительных 

баллов) 

Третий этап 

(уровень) 

 

Владеть: 

навыками практической работы с 

геоинформационными пакетами в которых 

обрабатываются геоизображения и 

фундаментальные различия при обработке 

изображений в тех или иных ГИС. 

Объем навыков 

оценивается на 59 

и менее баллов от 

требуемых 

Объем навыков   

оценивается от 60 до 

110 баллов от 

требуемых (включая 

10 поощрительных 

баллов) 

 

Критериями оценивания являются баллы, которые выставляются преподавателем за виды 

деятельности (оценочные средства) по итогам изучения модулей (разделов дисциплины), 

перечисленных в рейтинг-плане дисциплины: текущий контроль – максимум 50 баллов; рубежный 

контроль – максимум 50 баллов, поощрительные баллы – максимум 10. 

Шкалы оценивания зачета:  

зачтено – от 60 до 110 рейтинговых баллов (включая 10 поощрительных баллов), 

не зачтено – от 0 до 59 рейтинговых баллов). 

 

6 семестр  

Код и формулировка компетенции: ПК-4 - готовностью осуществлять получение 

оперативной гидрометеорологической информации и ее первичную обработку, обобщение 

архивных гидрометеорологических данных с использованием современных методов анализа и 

вычислительной техники 

Этап 

(уровень) 

освоения 

компетенции 

Планируемые результаты 

обучения 

(показатели достижения 

заданного уровня освоения 

компетенций) 

Критерии оценивания результатов обучения 

2 («Не 

удовлетворит

ельно») 

3 

(«Удовлетвори

тельно») 

4 («Хорошо») 

5 

(«Отлично»

) 

Первый этап 

(уровень) 

 

Знать: 

основные принципы работы в 

геоинформационных системах и 

различных ГИС-пакетах. 

Объем 

знаний 

оценивается 

на 44 и ниже 

баллов от 

требуемых 

Объем знаний 

оценивается от 

45 до 59 баллов 

от требуемых 

Объем знаний 

оценивается от 

60 до 79 баллов 

от требуемых 

Объем 

знаний 

оценивается 

от 80 до 110 

баллов от 

требуемых 

Второй этап 

(уровень) 

 

Уметь: 

пользоваться программным 

обеспечением, изучаемым, на 

Объем 

умений 

оценивается 

Объем умений 

оценивается от 

45 до 59 баллов 

Объем умений 

оценивается от 

60 до 79 баллов 

Объем 

умений 

оценивается 
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данном курсе, и на смежных 

дисциплинах, при работе с 

изображениями и 

картографической основой. 

на 44 и ниже 

баллов от 

требуемых 

от требуемых от требуемых от 80 до 110 

баллов от 

требуемых 

Третий этап 

(уровень) 

 

Владеть: 

навыками практической работы с 

геоинформационными пакетами 

в которых обрабатываются 

геоизображения и 

фундаментальные различия при 

обработке изображений в тех или 

иных ГИС. 

Объем 

владения 

навыками на 

44 и ниже 

баллов от 

требуемых 

Объем 

владения 

навыками от 45 

до 59 баллов от 

требуемых 

Объем 

владения 

навыками от 60 

до 79 баллов от 

требуемых 

Объем 

владения 

навыками 

от 80 до 110 

баллов от 

требуемых 

 

Критериями оценивания являются баллы, которые выставляются преподавателем за виды 

деятельности (оценочные средства) по итогам изучения модулей (разделов дисциплины), 

перечисленных в рейтинг-плане дисциплины: текущий контроль – максимум 40 баллов; рубежный 

контроль – максимум 30 баллов, поощрительные баллы – максимум 10. 

Шкалы оценивания экзамена:  

от 45 до 59 баллов – «удовлетворительно»; 

от 60 до 79 баллов – «хорошо»; 

от 80 баллов – «отлично». 
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4.2. Типовые контрольные задания или иные материалы, необходимые для оценки знаний, 

умений, навыков и опыта деятельности, характеризующих этапы формирования 

компетенций в процессе освоения образовательной программы. Методические 

материалы, определяющие процедуры оценивания знаний, умений, навыков и опыта 

деятельности, характеризующих этапы формирования компетенций 

 

5 семестр  
Этапы 

освоения 
Результаты обучения Компетенция Оценочные средства 

1-й этап 

 

Знания 

1. Знает основные принципы работы в 

геоинформационных системах и различных 

ГИС-пакетах. 

ПК-4 
Лабораторная работа 

Контрольная работа 

2-й этап 

 

Умения 

1. Умеет пользоваться программным 

обеспечением, изучаемым, на данном курсе, и 

на смежных дисциплинах, при работе с 

изображениями и картографической основой. 

ПК-4 
Лабораторная работа 

Контрольная работа 

3-й этап 

 

Владеть 

навыками 

1. Владеет навыками практической работы с 

геоинформационными пакетами в которых 

обрабатываются геоизображения и 

фундаментальные различия при обработке 

изображений в тех или иных ГИС. 

ПК-4 
Лабораторная работа 

Контрольная работа 

 

6 семестр  
Этапы 

освоения 
Результаты обучения Компетенция Оценочные средства 

1-й этап 

 

Знания 

1. Знает основные принципы работы в 

геоинформационных системах и различных 

ГИС-пакетах. 

ПК-4 
Лабораторная работа 

Контрольная работа 

2-й этап 

 

Умения 

1. Умеет пользоваться программным 

обеспечением, изучаемым, на данном курсе, и 

на смежных дисциплинах, при работе с 

изображениями и картографической основой. 

ПК-4 
Лабораторная работа 

Контрольная работа 

3-й этап 

 

Владеть 

навыками 

1. Владеет навыками практической работы с 

геоинформационными пакетами в которых 

обрабатываются геоизображения и 

фундаментальные различия при обработке 

изображений в тех или иных ГИС. 

ПК-4 
Лабораторная работа 

Контрольная работа 
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4.3. Рейтинг-план дисциплины 
Геоинформационные системы в гидрометеорологии 

 

направление 05.03.04 «Гидрометеорология», 

курс 3, семестр5 

 

Виды учебной деятельности 

студентов 

Балл за конкретное 

задание 

Число заданий 

за семестр 

Баллы 

Минимальны

й 
Максимальный 

Модуль 1. Определение геоинформационных систем (ГИС). Организация баз данных  

в гидрометеорологических ИС. 

Текущий контроль 

Выполнение и защита 

лабораторных работ 
5 за 1 работу 4 работы 0 20 

Рубежный контроль 

Контрольная работа 5 за 1 вопрос 5 вопросов 0 25 

Всего по модулю 0 45 

Модуль 2. Обработка гидрометеорологических данных. Особенности применения математического 

моделирования в гидрометеорологических ИС. 

Текущий контроль 

Выполнение и защита 

лабораторных работ 
6 за 1 работу 5  работ 0 30 

Рубежный контроль 

Контрольная работа 5 за 1 вопрос 5 вопросов 0 25 

Всего по модулю 0 55 

Поощрительный рейтинг за семестр 

1. Участие в олимпиаде по 

«Гидрометеорологии» 

2. Публикация статей 

3. Выступление на конференциях 

10 1 0 10 

Всего по поощрительному рейтингу 0 10 

Посещаемость (баллы вычитаются из общей суммы набранных баллов) 

Посещение     лекционных 

занятий 
По положению 9 занятий 0 -6 

Посещение лабораторных 

занятий 
По положению 9 занятий 0 -10 

Всего по посещаемости 0 -16 

Итоговой контроль 

Зачет   - - 

ИТОГО 0 110 
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Лабораторные работы 

 

Лабораторная работа № 1.  Изучение данных в ArcMap.  

Цель задания: Выявить, как организованы пространственные данные, основанные на теме, 

их представляющей. Изучить отношения между слоями карты и данными, на которые эти слои 

ссылаются.  

Порядок выполнения задания: 

1. Запуск ArcMap. 

2. Работа со слоями. 

3. Изменение символа. 

4. Добавление слоев к ArcMap. 

5. Изучение панели инструментов. Инструменты (TOOLS). 

6. Создание выборок объектов и записей.  

7. Сохранение карты.  

Результат выполнения задания:  Сохранить документ карты под новым именем. 

Продемонстрировать работу преподавателю. Закрыть ArcMap. 

 

Лабораторная работа № 2. Управление слоями карты в ArcMap. 

Цель задания: Ознакомление с различными технологиями, которые позволяют работать с 

поднаборами данных вместо того, чтобы загружать все слои и все пространственные объекты в 

каждом слое. Изучение различных способов перемещения к определенному экстенту карты.  

Порядок выполнения задания: 

1. Открытие документа карты.  

2. Приближение к слою и объекту. 

3. Создание закладки. 

4. Создание определяющего запроса. 

5. Задание диапазона масштабов для слоя аэропорты. 

6. Добавление слоя и написание другого определящего запроса.  

7. Сравнение слоев водные объекты и озера. 

8. Импорт символов слоя озера. 

9. Создание слоя выборки. 

10. Изучение слоя озера выборка. 

11. Создание составного слоя. 

12. Задание свойств слоя.  

13. Создание файла слоя.  

14. Создание пакета слоев. 

Результат выполнения задания:  Сохранить документ карты под новым именем. 

Продемонстрировать работу преподавателю. Закрыть ArcMap. 

 

Лабораторная работа № 3. Изучение отношений объекрт-атрибут в ArcMap. Изучение 

преимуществ отношений объект-атрибут.  

Цель задания: Изучение таблицы атрибутов, которая является базой данных, содержащих 

информацию о наборе географических объектов. Отображение и надписывание объектов карты и 

присваивание символов слою на основе информации из атрибутивной таблицы.  

Порядок выполнения задания: 

1. Запуск ArcMap и открытие документа карты.  

2. Просмотр объектов карты и атрибутивной таблицы.  

3. Включение подсказок карты (Maptips). 

4. Отображение символами пространственных объектов. 

5. Подписывание объектов.  

6. Переименование фрейма данных.  

7. Добавление данных и присвоение символов. 

8. Надписывание объектов. 

9. Вставка и переименование фрейма данных.  
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10. Добавление данных во фрейм данных.  

11. Присвоение символов слою постройки (Cabins). 

12. Надписывание объектов слоя кемпинги. 

13. Включение подсказок карты (Maptips). 

Результат выполнения задания: Сохранить документ карты под новым именем. 

Продемонстрировать работу преподавателю. Закрыть ArcMap. 

 

Лабораторная работа № 4. Создание компоновки карты  в ArcMap. 

Цель задания: создание карты в виде компоновки. Применять шаблоны и экспортировать 

карту.  

Порядок выполнения задания: 

1. Работа с фреймами данных Гавайи и Аляска.  

2. Сравнение данных и вида компоновки. 

3. Работа с закладками.  

4. Применение шаблона к компоновке карты. 

5. Редактирование элемента карты. 

6. Сохранение и экспорт компоновки карты. 

7. Создание компоновки карты в обратном порядке.  

7.1.Запуск ArcMap и сохранение документа карты.  

7.2. Присвоение символа слою. 

7.3. Надписывание объектов. 

7.4. Задание параметров страницы. 

7.5. Переключение в вид компоновки.  

7.6. Добавление элементов карты.  

7.7. Сохранение и экспорт компоновки карты.  

Результат выполнения задания: Сохранить документ карты под новым именем.  

Экспортировать карту в формате PDF. Продемонстрировать работу преподавателю. Закрыть 

ArcMap. 

 

Лабораторная работа № 5. Работа с надписями  в ArcMap. 

Цель задания: Изучить возможности надписывания объектов, работа с различными 

опциями надписей объектов.  

Порядок выполнения задания: 

1. Включение надписей слоя Провинций.  

2. Удаление дублирующих надписей.  

3. Изменение атрибутов, используемых для надписей.  

4. Изменение символа надписи. 

5. Изучение свойств размещения надписей для полигонов. 

6. Изучение присвоения весов надписям. 

7. Добавление класса надписей и присваивание символа. 

8. Установка диапазонов масштабов. 

9. Создание надписей для крупных городов с использованием запроса.  

10. Выбор символа надписи для крупных городов. 

11. Настройка весов надписей. 

12. Изучение свойств размещения надписей для точек. 

13. Надписи линейных объектов. 

14. Добавление выражения для надписи.  

Результат выполнения задания: Сохранить документ карты под новым именем.  

Экспортировать карту в формате PDF. Продемонстрировать работу преподавателю. Закрыть 

ArcMap. 

 

Лабораторная работа № 6. Работа с проекциями в ArcMap. 

Цель задания: изучение и работа с проекциями.  

Порядок выполнения задания: 



18 

 

1. Определение масштаба карты.  

2. Исследуйте, как проекция карты может влиять на расстояние.  

3. Рассмотрите, как проекция карты влияет на форму.  

4. Работа с неизвестной проекцией.  

4.1.Открытие документа карты и добавление данных в карту. 

4.2.Изучение слоя CanadaMountains. 

4.3.Задание системы координат CanadaMountains. 

Результат выполнения задания: Сохранить документ карты под новым именем.  

Экспортировать карту в формате PDF. Продемонстрировать работу преподавателю. Закрыть 

ArcMap. 

 

Лабораторная работа № 7. Создание и документирование данных  в ArcMap. 

Цель задания: Создание новой базы геоданных и нового класса пространственных 

объектов.  

Порядок выполнения задания: 

1. Создание новой базы геоданных. 

2. Изучение данных OSU. 

3. Добавление и удаление полей. 

4. Добавление значений в новое поле. 

5. Создание класса пространственных объектов и задание его свойств. 

6. Задание атрибутов для нового класса пространственных объектов.  

7. Поиск футбольного стадиона. 

8. Добавление нового объекта в класс пространственных объектов. 

9. Добавление атрибутивных значений для объекта. 

10. Документирование нового класса объектов. 

11. Создание нового класса объектов в существующей базе геоданных.  

12. Подготовка среды для цифрования. 

13. Добавление линейных объектов. 

Результат выполнения задания: Сохранить документ карты под новым именем.  

Экспортировать карту в формате PDF. Продемонстрировать работу преподавателю. Закрыть 

ArcMap. 

 

Лабораторная работа № 8. Регистрация данных в географическом пространстве в ArcMap. 

Цель задания: Научиться преобразовывать произвольные координаты в географические.  

Порядок выполнения задания: 

1. Панель инструментов Векторная трансформация.  

2. Панель инструментов Пространственная привязка. 

Результат выполнения задания: Сохранить документ карты под новым именем.  

Экспортировать карту в формате PDF. Продемонстрировать работу преподавателю. Закрыть 

ArcMap. 

 

Лабораторная работа № 9. Проверка атрибутов в ArcMap. 

Цель задания: Научиться создавать подтипы и домены, чтобы быть уверенным в 

корректной загрузке данных в базу геоданных.  

Порядок выполнения задания: 

1. Определение подтипов. 

2. Создание домена для всего атрибутивного поля.  

3. Проверка подтипов и доменов. 

Результат выполнения задания: Сохранить документ карты под новым именем.  

Экспортировать карту в формате PDF. Продемонстрировать работу преподавателю. Закрыть 

ArcMap. 

 

Критерии  оценки  работ 1 модуля 
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Модуль 1. Лабораторная работа оценивается в 5 баллов за 1 работу. Всего 4 лабораторных 

работы.  

Критерии оценки (в баллах) в соответствии рейтинг плану по максимальному и 

минимальному  количеству баллов: 

5 баллов выставляется студенту, если продемонстрировал умение применять 

теоретические знания при выполнении практических заданий. Лабораторная работа выполнена 

полностью без неточностей и ошибок. 

4 балла выставляется студенту, если при выполнении лабораторной работы допущены 

несущественные ошибки. 

3 балла выставляется студенту, если при выполнении лабораторной работы заметны 

пробелы в теоретических знаниях. 

2 балла  студент не полностью выполнил задание или при решении допущены 

значительные ошибки. 

1 балл выставляется студенту, если при выполнении лабораторной работы студент не 

полностью выполнил задание и при решении допущены грубые ошибки.  

 

Критерии  оценки  работ 2 модуля 

Модуль 2. Лабораторная работа оценивается в 6 баллов за 1 работу. Всего 5 лабораторных 

работ.  

Критерии оценки (в баллах) в соответствии рейтинг плану по максимальному и 

минимальному  количеству баллов: 

6 баллов выставляется студенту, если продемонстрировал умение применять 

теоретические знания при выполнении практических заданий. Лабораторная работа выполнена 

полностью без неточностей и ошибок. 

4-5 балла выставляется студенту, если при выполнении лабораторной работы допущены 

несущественные ошибки. 

3 балла выставляется студенту, если при выполнении лабораторной работы заметны 

пробелы в теоретических знаниях. 

2 балла  студент не полностью выполнил задание или при решении допущены 

значительные ошибки. 

1 балл выставляется студенту, если при выполнении лабораторной работы студент не 

полностью выполнил задание и при решении допущены грубые ошибки.  

 

Типовые задания для контрольной работы 

Описание контрольной работы: Письменная контрольная работа направлена на оценивание 

усвоения ЗУН, направлена на оценивание теоретических знаний по дисциплине. Контрольная 

работа в 1 варианте, в каждом варианте по 5 вопросов. Каждый ответ на вопрос оценивается в 5 

баллов, согласно рейтинг-плану. 

 

Перечень вопросов для подготовки к контрольной работе по Модулю 1 

1. Определение геоинформационных систем (ГИС).  

2. Понятие ГИС.  Их структура.  

3. Классификация ГИС: по назначению, по проблематической ориентации, по  

территориальному охвату, по способу организации географических данных.  

4. Функциональные требования к ГИС: автоматизированное картографирование, 

пространственный анализ, управление данными.   

5. Применение ГИС в научных исследованиях.  

6. Компьютерные технические средства и устройства поддержки ГИС.  

7. Программное обеспечение: системное, базовое и прикладное.  

8. История развития ГИС.  

9. Общие представления о гидрометеорологической информационной системе: специфика 

гидрометеорологической информационной системы (ИС), задачи гидрометеорологической 

ИС, требования к техническим средствам, поддерживающим гидрометеорологические ИС.  

10. Организация баз данных в гидрометеорологических ИС.  
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11. Гидрометеорологические данные: синоптическая информация, аэрологические данные, 

океанологическая и гидрологическая съемки, данные спутникового мониторинга атмосферы и 

гидросферы и т.д.  

12. Ввод данных в ГИС.  

13. Организация баз гидрометеорологических данных: географические сведения, морфология, 

гидрометеорологическая информация. 

 

Перечень вопросов для подготовки к контрольной работе по Модулю 2 

1. Обработка гидрометеорологических данных.  

2. Расчет статистической информации.  

3. Методы восстановления гидрометеорологических полей: оптимальная интерполяция, метод 

взвешенных коэффициентов, сплайн-интерполяция и др.  

4. Редактирование и обновление базы данных (БД).  

5. Расчет дополнительных параметров по этим данным.  

6. Вывод и визуализация данных. Технические средства.  

7. Методы визуализации данных: растровая и векторная графика.  

8. Особенности создания компьютерных гидрометеорологических карт и атласов. 

9. Отображение пространственно-временных гидрометеорологических характеристик.  

10. Особенности применения математического моделирования в гидрометеорологических ИС.  

11. Информационное единство динамической модели и измерений.  

12. Адаптация модели к исходным данным.  

13. Мультимедийная визуализация результатов моделирования.  

14. Имитационное моделирование. 

 

Пример варианта контрольной работы 

Модуль 1. 

Вопросы текущего контроля. Модуль 1. 

1. Определение геоинформационных систем (ГИС). Понятие ГИС.  Их структура. 

2. В чем заключается разница между классом пространственных объектов и слоем? 

3. Сравните файл слоя и пакет слоев. В каком случае можно использовать один из них, а в каком - 

оба? 

4. Назовите один способ присвоения символов количественным данным.  При добавлении 

надписей к карте, откуда берется поле надписи?  

5. Назовите некоторые отличия Вида данных и Вида компоновки. Для чего нужно 

использовать Вид компоновки? 

Модуль 2. 
Вопросы текущего контроля. Модуль 2. 

1. Что такое база геоданных? 

2. Что такое класс пространственных объектов? Прежде чем добавлять объект в класс 

объектов, сначала необходимо добавить класс объектов в базу геоданных? 

3. Какая возможная причина того, что надписи некоторых городов могут быть скрыты? 

4. Как проекция карты может повлиять на расстояние? На форму?  

5. Что такое атрибутивная таблица?  

 

Критерии оценки (в баллах): 

25 баллов выставляется студенту, если студент дал полные, развернутые ответы на все 

теоретические вопросы. 

от 20 до 25 баллов выставляется студенту, если студент дал полные, развернутые ответы на 

несколько вопросов, однако допущены неточности в ответе на 1 вопрос. 

от 15 до 20 баллов выставляется студенту, если студент дал полные, развернутые ответы на 

несколько вопросов, однако допущены неточности в ответах на 1, 2 вопроса. 

от 10 до 15 баллов выставляется студенту, если студент дал полные, развернутые ответы на 

пару вопросов, однако допущены неточности в ответах на остальные вопросы. 
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от 5 до 10 баллов выставляется студенту, если студент дал не совсем развернутые ответы 

на пару вопросов, однако допущены неточности в ответах на 1, 2 вопроса. 

от 0 до 5 баллов выставляется студенту, если ответ на теоретические вопросы 

свидетельствует о непонимании и крайне неполном знании основных понятий и методов. 
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4.3. Рейтинг-план дисциплины  
Геоинформационные системы в гидрометеорологии 

 

направление 05.03.04 «Гидрометеорология», 

курс 3, семестр 6 

 

Виды учебной деятельности 

студентов 

Балл за конкретное 

задание 

Число 

заданий за 

семестр 

Баллы 

Минимальный Максимальный 

Модуль 1. Оптимизация гидрометеорологических ИС. Средства доступа к гидрометеорологическим базам 

данных. 

Текущий контроль 

Выполнение и защита 

лабораторных  работ 
5 за 1 работу 3 работы 0 15 

Рубежный контроль 

Контрольная работа 3 за 1 вопрос 5 вопросов 0 15 

Всего по модулю 0 30 

Модуль 2. Особенности гидрометеорологических ИС для Интернет. Обзор современных 

гидрометеорологических ИС. 

Текущий контроль 

Выполнение и защита 

практических работ 

6 за 1 работу 

7 за 1 работу 

3  работы 

1 работа 
0 

18 

7 

Рубежный контроль 

Контрольная работа 3 за 1 вопрос 5 вопросов 0 15 

Всего по модулю 0 40 

Поощрительный рейтинг за семестр 

1. Участие в олимпиаде 

по «Гидрометеорологии» 

2. Публикация статей 

3. Выступление на 

конференциях 

10 1 0 10 

Всего по поощрительному рейтингу 0 10 

Посещаемость (баллы вычитаются из общей суммы набранных баллов) 

Посещение     лекционных 

занятий 
По положению 14 занятий 0 -6 

Посещение лабораторных 

занятий 
По положению 13 занятий 0 -10 

Всего по посещаемости 0 -16 

Итоговой контроль 

Экзамен     30 

ИТОГО 0 110 
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Экзамен 

 

Типовые экзаменационные вопросы для подготовки к тесту  

 

1. Оптимизация гидрометеорологических ИС.  

2. Критерии качества: простота вычислительного алгоритма, минимальная стоимость затрат на 

проведение натуральных экспериментов и т.д.  

3. Средства доступа к гидрометеорологическим базам данных.  

4. Работа с гидрометеорологическими данными при помощи приложений: «сервера», 

представляющего данные из общей базы данных, и «клиента», запрашивающего данные у 

«сервера». 

5. Приложение «сервер»: режимы функционирования, структура размещения ресурсов, настройки 

«сервера», форматы системных журналов, взаимосвязь между настройками «сервера» и 

настройками ядра операционной системы, организация корпоративных данных из БД. 

6. Приложение «клиент»: одновременный доступ к нескольким серверам, одновременный доступ 

внутри одного «сервера» к нескольким базам данных. 

7. Особенности гидрометеорологических ИС для Интернет.  

8. Возможности, предоставляемые пользователям ГИС для Интернет. 

9. Проблемы безопасности в гидрометеорологических ИС. Контроль прав доступа. Контроль 

регистрационных журналов. Фильтрация пакетов. Резервное копирование и восстановление 

данных. Шифрование данных. 

10. Обзор современных гидрометеорологических информационных систем. Основные 

компоненты. Приложения. Телекоммуникация. Основные принципы работы. Региональные 

гидрометеорологические ИС. 

11. Определение морфометрических, ландшафтных и гидрографических характеристик речного 

водосбора в ArcMap. 

12. Основы работы с пространственными данными (визуализация). Создание климатической 

карты мира в ArcMap. 

13. Какие типы геометрии допустимы для слоев в базе геоданных? К каким типам относятся слои, 

использованные вами в работе? 

14. В какой системе координат хранились данные, которые вы использовали для составления 

карты? 

15. Какая проекция была использована вами в работе? К какому типу по характеру искажений она 

относится? 

16. Где хранятся данные, которые используются для классификации символов при отображении, 

изменения их размера и направления? 

17. За что отвечают системные поля Shape и ObjectID? 

18. Чем отличается вид компоновки от вида данных? 

19. Анализ гидрографических сетей в ArcMap. 

20. Каким требованиям должны отвечать гидрографические данные, чтобы их можно было 

представить в виде геометрической сети? 

21. Какие функции выполняют флаги и барьеры при решении задач сетевого анализа? 

22. Какие задачи можно решать с помощью анализа геометрических сетей? 

23. Какие преимущества при редактировании данных дает топологическая структура данных? 

24. Анализ цифровой модели рельефа в ArcMap. 

25. Что представляет растр направления тока? 

26. Что представляет собой растр аккумуляции тока? 

27. Как можно выделить водотоки по растру аккумуляции тока? 

28. Как получаются порядки рек методом Стралера? 

29. После того как выделены водотоки, какую последовательность действий нужно выполнить, 

чтобы построить для них границы бассейнов? 

30. Как можно рассчитать статистику по бассейнам? Опишите последовательность действий. 

31. Привязка и цифрование гидрогеологической карты в ArcMap. 
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32. В какой последовательности расставляются контрольные точки при привязке данных? Каково 

их оптимальное расположение? 

33. Какой метод трансформирования изображения вы использовали в работе? В чем его суть? 

34. Как пристыковать один полигон к другому, не оцифровывая их общую границу? Опишите 

последовательность действий. 

35. Что позволяют делать атрибутивная и пространственная выборки? (дополнительно) 

36. В чем суть операции оверлея слоев? Чем эта операция отличается от пространственной 

выборки? (дополнительно) 

37. Пространственная интерполяция характеристик годового стока с использованием ГИС-

технологий в ArcMap. 

38. Расчет характеристик годового стока на основе интерполяционных в ArcMap. 

 

Образец теста 

В какой системе встроен модуль DataBaseIntegrator, обеспечивающий связывание 

картографических данных с табличными данными в самых мощных реляционных СУБД?  

А) ИнГЕО 

Б) ARC/INFO 

В) Арго 

Г) Панорама 

Критерии оценивания: 

Каждый вопрос оценивается в 2 балла. В целом экзамен состоит из 15 вопросов. 

 

Критерии оценки экзамена (в баллах): 
- 24-30 баллов выставляется студенту, если студент дал точные ответы на 12-15 вопросов теста.  

- 18-23 баллов выставляется студенту, если студент дал точные ответы на 9-11 вопросов теста.  

- 10-17баллов выставляется студенту, если студент дал точные ответы на 5-8 вопросов теста.  

- 1-9 баллов выставляется студенту, если студент дал точные ответы на 1-4 вопросов теста. 

 

Лабораторные работы 

Лабораторная работа № 1.  

Определение морфометрических, ландшафтных и гидрографических характеристик 

речного водосбора.  

Цель задания:  

 Определить границы, площадь, центр тяжести, среднюю высоту, уклон речного 

водосбора;  

 Определить длину исследуемой рекеи и общую протяженность русловой сети, 

коэффициенты густоты речной сети; 

 Определить площадь озер, болот, залесенных территорий.  

Порядок выполнения задания: 

Создание и привязка ГИС-проекта.  Добавить в новый ГИС-проект тематические слои – 

русловой сети, озер, болот и лесов, и привязанный растровый файл с топографической картой. 

Выбрать для нового ГИС-проекта проекцию и систему координат.  

Определение границ и центра тяжести речного водосбора. Границы проводятся по 

наивысшим отметкам на периферии водосбора и с учетом косвенных признаков, в частности, 

положения истоков притоков вблизи водораздела, береговой линии водоемов и т.п. Для 

определения границ водосборов необходимо создать новый полигональный шейп-файл, 

используемый для хранения и отображения плановых объектов.  

Идентификация объектов в пределах исследуемого речного водосбора и определение их 

размеров.  

Определение средней высоты и уклона водосбора на основе ЦМР. Загрузить файл с 

моделью рельефа. Для получения значений средней высоты водосбора необходимо открыть 

атрибутивную таблицу созданного растра – нажать правой кнопкой на название столбца со 

значениями абсолютных высот в растровых ячейках – выбрать команду Statistics.  
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Результат выполнения задания:  Составить пояснительную записку (с анализом точности 

полученных величин) и оформить задание в соответствии с требованиями. Полученные 

характеристики свести в единую таблицу и сравнить с опубликованными в справочной 

литературе.  

 

Лабораторная работа № 2.  

Основы работы с пространственными данными (визуализация). Создание климатической 

карты мира.  

Цель задания: Визуализация данных на карте с использованием слоев различных моделей 

данных и объектов. 

Порядок выполнения задания: 

Запустите приложение ArcMap и откройте окно Catalog, нажав кнопку  на панели 

инструментов. Раскройте базу данных MapData.gdb и изучите ее содержимое. Дважды щелкните 

на слое Climates и перейдите на вкладку XY Coordinate System. 

Оформление базовых слоев. Добавьте на карту слой Countries, просто перетащив его из 

окна каталога. Дважды щелкните на названии слоя Countries и перейдите на вкладку Symbology. 

Внимательно изучите список способов изображения слева. Они разделены на 

категории Features (единый символ), Categories (качественные характеристики), Quantities 

(количественные  характеристики), Charts (картодиаграммы), Multiple Attributes (способы 

изображения по нескольким атрибутам). Разверните каждую группу и щелкните на каждом 

способе. Выберите способ единого символа (Features > Single symbol).  

Измените проекцию карты на проекцию Робинсона (Robinson). Ее можно найти в 

группе Projected Сoordinate Systems > World. Обратите внимание на то, как изменятся очертания 

объектов. 

Добавьте на карту слой Coast, расположите его поверх слоя Countries и измените цвет 

линии на Delft Blue. 

Добавьте на карту слой Rivers расположите его поверх слоя Coast и измените цвет линии 

на Delft Blue, а толщину сделайте равной 0,5 пиксела. 

Добавьте на карту слой Lakes, расположите его поверх слоя Rivers . 

Добавьте на карту слой Cities, расположите его поверх слоя Lakes. 

Оформление данных о климате и морских течениях. Добавьте на карту слой Сlimates, 

расположите его внизу таблицы содержания.  Откройте таблицу атрибутов слоя Сlimates, 

щелкнув на его названии правой кнопкой мыши и выбрав команду Open Attribute Table. 

Найдите в ней столбец Type, просмотрите его значения. Это поле таблицы хранит информацию 

о типе климата для каждой области. Вы будете использовать ее для классификации при 

отображении данного слоя. Найдите поля Shape и ObjectID. 

Климатические пояса показываются на картах способом качественного фона. 

Добавьте на карту слой Сurrents, расположите его поверх слоя Сlimates. Этот слой 

содержит данные о течениях OSCAR (Ocean Surface Current Analyses – Real time), осредненные 

с 1993 по 2003 год. 

Настройка подписей. Включите механизм размещения подписей Maplex. Дважды 

щелкните на слое Cities, и перейдите на вкладку Labels. Включите подписи для слоя Cities.  

Настройка компоновки. Переключитесь в вид компоновки с помощью команды 

меню View — Layout View. Добавьте на карту легенду с помощью команды Insert > Legend, 

включив в нее только слои Климат и Течения.  

Разместите над картой текст «КЛИМАТ И ОСНОВНЫЕ ОБЪЕКТЫ ГИДРОСФЕРЫ». 

Разместите под картой по центру численный масштаб 1:90 000 000. 

Разместите в правом нижнем углу карты текст «Выполнил» и свое ФИО. 

Результат выполнения задания:   

1. Экспортируйте карту из режима компоновки в формат PNG с разрешением 300 

точек на дюйм с помощью команды File > Export Map. Сохраните его в свою директорию. 

2. Вставьте карту в отчетный файл. 

 

Лабораторная работа № 3.  
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Анализ гидрографических сетей.  

Цель задания: научиться моделировать речную сеть с помощью геометрических методов. 

Порядок выполнения задания: 

Откройте ArcMap. Щелкните правой кнопкой мыши по домашнему каталогу (Home) и 

выберите New > File Geodatabase для того, чтобы создать новую базу геоданных. Щелкните 

по Ex.gdb правой кнопкой мыши и выберите пункт Make Default Geodatabase. Эта команда 

указывает системе, что все результаты обработки данных следует помещать в выбранную базу 

геоданных. 

Добавьте в базу геоданных Ex.gdb новый набор данных Hydro. Для этого щелкните 

правой кнопкой мыши на названии базы геоданных и в контекстном меню выберите New > 

Feature Dataset. 

В следующем окне вам просят задать проекцию. Щелкните на кнопке  Add Coordinate 

System и в ниспадающем меню выберите команду Import. Найдите слой Border базе геоданных 

Satino.gdb и дважды кликните на нем. Параметры проекции автоматически подставятся из 

созданного ранее слоя. Убедитесь, что проекция называется WGS_1984_UTM_Zone_37N. 

Создайте новый класс пространственных объектов Streams внутри набора данных Hydro. 

Для этого щелкните правой кнопкой мыши по набору данных Hydro и в контекстном меню 

выберите пункт New—Feature Class. 

В первом диалоге введите название класса Streams, его псевдоним (alias) Водотоки и из 

ниспадающего списка выберите тип класса Line Features. Нажмите Далее два раза, чтобы 

пропустить второй диалог. 

Нажмите кнопку Import и найдите класс WaterLine в базе геоданных  Satino.gdb, дважды 

щелкните на нем. Названия и типы полей автоматически подставятся в список.  

Нажмите Finish. Проверьте, чтобы в вашей таблице содержания было 3 

слоя: Водотоки, Гидрография (линии) и Гидрография (полигоны). 

Копирование и цифрование линий водотоков. Щелкните правой кнопкой мыши на 

слое Водотоки и выберите пункт меню Edit Features > Start Editing, чтобы начать 

редактирование. Выделите все водотоки из слоя Гидрография (линии). Для этого щелкните 

правой кнопкой мыши по слою Гидрография (линии) и в контекстном меню выберите 

пункт Selection > Select All. Скопируйте выделенные водотоки в буфер обмена через команду 

главного меню Edit > Copy. 

Вставьте скопированные объекты в слой Водотоки. Для этого воспользуйтесь 

стандартной командой главного меню Edit > Paste и в появившемся диалоге выберите в 

качестве целевого слой Водотоки. 

Снимите выделение с водотоков, нажав кнопку  Clear Selected Features на панели 

инструментов Tools. Удалите слой Гидрография (линии) из таблицы содержания. В этом 

задании он больше вам не понадобится. Переключитесь в окно Create Features c помощью 

кнопки  на панели Tools и выберите Водотоки в списке цифруемых объектов.  

Приблизьтесь к верховьям Протвы в западной части карты. Для навигации используйте 

колесико мыши (масштабирование) и кнопку  на клавиатуре (перемещение). Рекомендуемый 

диапазон масштабов для цифрования — 1:1 500–1:2000. Вы можете его отслеживать вверху 

окна. Щелкните посередине полигона в месте начала реки и начните цифровать линию 

примерно по осевой линии полигона с определенным интервалом. Щелкните мышью в месте, 

где вы хотите поставить точку, затем переместите курсор к месту следующей точки, щелкните 

еще раз, и так далее. Не увлекайтесь и не расставляйте точки слишком часто. Оцифруйте 

осевую линию Протвы целиком с запада на восток — это займет у вас некоторое время. 

Когда линия будет полностью оцифрована, щелкните дважды мышью в последней точке, 

или нажмите. Сохраните изменения, выбрав на панели Editor команду Editor > Save Edits. 

Снимите выделение с водотоков, нажав кнопку  Clear Selected Features на панели 

инструментов Tools. Нажмите глобус  Full extent, чтобы все объекты поместились на экране. 

Притягивание (снэппинг) притоков и разрезание осевой линии основных рек. Найдите 

устье реки Межиловки при впадении в Протву (западная часть полигона) и увеличьтесь так, 

чтобы было хорошо видно место впадения. Возьмите стрелку  на панели Editor и дважды 
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щелкните на линии ручья. Должны появиться вершины. Потяните за последнюю вершину и 

пристыкуйте ее к линии реки. Щелкните на пустом месте, чтобы завершить редактирование.  

Повторите операцию для всех остальных ручьев. Перемещайтесь по карте, используя 

клавишу. Не забудьте также про Исьму. Сохраните изменения, выбрав команду Editor > Save 

Edits 

Помимо сохранения связности для геометрической сети очень важно, чтобы линии были 

разрезаны на сегменты между пересечениями.  

Выделите на карте Протву и приблизьтесь к месту впадения в нее реки Межиловки. 

Найдите на панели Editor инструмент разрезания линии  и щелкните мышью в месте впадения 

ручья в Протву. Линия Протвы разобьется этой точкой на 2 части. 

Повторите процедуру с выделением Протвы и разрезанием для всех остальных притоков. 

Разрежьте аналогичным образом остальные водотоки. Сохраните изменения, выбрав 

команду Editor > Save Edits. Завершите редактирование, выбрав команду Editor > Stop Editing. 

Сохраните документ карты. 

Установка точки стока. Перейдите в окно Каталога, щелкните правой кнопкой мыши по 

набору данных Hydro и выберите пункт New > Feature Class. Задайте классу имя Sink и 

точечный тип Point Features. Остальные параметры оставьте по умолчанию. Смените символ 

слоя Sink на кружок голубого цвета диаметром 10 пикселов. Включите режим редактирования с 

помощью команды Edit Features > Start Editing, в окне Create Features выберите Sink и поставьте 

точку на восточной оконечности реки Протвы (правый край карты). Сохраните изменения и 

завершите режим редактирования. Добавьте на карту слой горизонталей ContoursBasic из базы 

данных  Satino.gdb и смените цвет линий на бледно-серый. Переместите его вниз в качестве 

основы. Отключите слой Гидрография (полигоны) и нажмите кнопку  Full extent, чтобы вся 

территория полигона поместилась на экране. 

Построение и настройка геометрической сети.  Перейдите в окно Каталога, щелкните 

правой кнопкой мыши по набору данных Hydro и выберите пункт New > Geometric Network. 

Оставьте Hydro_Net в качестве имени по умолчанию и установите расстояние принудительного 

снэппинга линий равным 1 м. Эта опция будет полезна, если вы где-то не дотянули устье 

притока до реки. Оно дотянется автоматически. Нажмите Далее. В следующем окне 

нажмите Select All, чтобы выбрать слои, участвующие в построении сети. Нажмите Далее. 

Перед вами окажется диалог настройки ролей. Junction — это узел, Edge — это ребро. Для слоя 

Sink установите значение параметра Sources & Sinks равным Yes. Система будет знать, что этот 

слой содержит точки, являющиеся истоками либо стоками. Нажмите Finish в последнем 

диалоге, чтобы завершить создание сети. После того как будет построена геометрическая сеть, 

в таблицу содержания добавятся 3 новых слоя: Водотоки (ребра 

сети), Hydro_Net_Junctions (сочленения в сети) и Sink (точка стока). Удалите новые 

слои Водотоки и Sink, поскольку они дублируют старые.  Включите режим редактирования и 

откройте таблицу атрибутов слоя Sink. 

Установите для единственной точки в этом слое поле AncillaryRole равным 2 (Sink). Если 

список не отображается, просто введите в ячейку 2. Обратите внимание на то, что есть и 

противоположный вариант — Source (исток). 

Сохраните изменения, выбрав пункт меню Editor > Save Edits. 

Щелкните правой кнопкой мыши на пустом поле вверху окна и откройте панель 

инструментов Utility Network Analyst, предназначенную для работы с геометрической сетью. 

Выберите в меню пункт Flow > Display Arrows для того чтобы система автоматически 

показала направление течения. Вдоль отрезков будут показаны кружки, означающие, что 

направление еще не задано. 

Нажмите кнопку  Set Flow Direction. Кружки должны смениться стрелочками, 

указывающими направление течения. Просмотрите разные части карты и убедитесь в том, что 

направление течения задано одинаково верно для всех водотоков. Завершите сеанс 

редактирования, выбрав на панели Editor пункт меню Editing > Stop Editing.   

Анализ и редактирование геометрической сети.  Откройте меню флагов и барьеров на 

панели инструментов Utility Network Analyst. Поставьте флажок в месте впадения 
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реки Межиловки в Протву. В списке Trace Task выберите задачу Trace Upstream (трассировать 

вверх по течению) и нажмите кнопку  Solve. 

Инструмент анализа выделит водотоки, расположенные выше по течению относительно 

заданной точки. Весь их сток в конечном счете попадает в данную точку. Смените задачу 

на Trace Downstream и опять нажмите кнопку  Solve. Инструмент анализа построит маршрут 

вниз по течению. Поставьте еще один флажок в верховьях ручья Язвицы и запустите анализ в 

режиме Find Path. Будет построен маршрут между двумя точками. 

Поставьте точечный барьер в месте впадения Исьмы в Протву и попробуйте еще раз 

рассчитать маршрут. Очистите флаги и барьеры, выбрав Analysis > Clear Flags и Analysis > Clear 

Barriers. Попробуйте поэкспериментировать с разными режимами расчетов в меню Trace Task и 

расстановкой флагов и барьеров. Включите режим редактирования снова и приблизьтесь к 

месту впадения любого ручья в Протву. Выделите узел сочленения и переместите его в сторону. 

Сохраните документ карты еще раз. 

Результат выполнения задания:   

1. Экспортируйте карту из режима компоновки в формат PNG с разрешением 300 

точек на дюйм с помощью команды File > Export Map. Сохраните его в свою директорию. 

2. Вставьте карту в отчетный файл. 

 

Лабораторная работа № 4.  

Анализ цифровой модели рельефа.  

Цель задания: научиться на основе цифровой модели рельефа выделять водотоки и их 

водосборные бассейны в автоматическом режиме. Осуществлять расчет статистики по высотам в 

рамках выделенных бассейнов 

Порядок выполнения задания: 

Подключитесь в окне каталога к вашей папке Ex. Убедитесь, что в ней находится база 

геоданных Ex.gdb. Используя контекстное меню базы данных, назначьте ее базой данных по 

умолчанию.  Добавьте на карту слой dem. Это цифровая модель рельефа в растровом формате. 

Измените оформление слоя.  

Измените красный цвет шкалы на оранжевый. Для этого в контекстном меню цветовой 

шкалы выберите команду Properties…. В появившемся диалоге дважды щелкните на бело-красном 

градиенте и замените красный цвет на оранжевый Electron Gold.  

Завершите настройку шкалы, нажав ОК и еще раз ОК. 

Измените сортировку значений на вкладке Symbology таким образом, чтобы вверху 

оказались самые большие высоты. Нажмите ОК, чтобы закрыть диалог настройки слоя. 

Измените название слоя dem на «Послойная окраска».  Дополнительно к послойной окраске 

постройте горизонтали, чтобы усилить пластику рельефа. Для этого запустите инструмент 

геообработки Spatial Analyst Tools > Surface > Contour и заполните его параметры.  

Растр направления тока показывает в каждой ячейке направление максимального уклона. 

Он необходим для построения водосборных бассейнов и прочих задач гидрологического и 

морфометрического анализа. Для построения растра направлений тока запустите инструмент 

Spatial Analyst Tools > Hydrology > Flow Direction и заполните его параметры.  

Для построения растра аккумуляции тока запустите инструмент Spatial Analyst Tools > 

Hydrology > Flow Accumulation и заполните его параметры.  

Чтобы сделать отображение растра аккумуляции тока более наглядным, откройте его 

свойства и на вкладке Symbology измените растяжку гистограммы на метод Histogram Equalize 

(Выравнивание гистограммы).  

Для получения векторных линий водотоков воспользуйтесь инструментом Spatial Analyst 

Tools > Hydrology > Stream to Feature и заполните его параметры. 

Переименуйте полученный слой в Водотоки. Визуализируйте водотоки в соответствии с их 

порядками от 1 до 4. 

Запустите инструмент Spatial Analyst Tools > Hydrology > Snap Pour Point и заполните его 

параметры. Для построения границ водосборных бассейнов запустите инструмент Spatial Analyst 

Tools > Hydrology > Watershed и заполните его параметры. Конвертируйте полученные бассейны в 
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векторные полигоны. Для этого запустите инструмент Conversion Tools > From Raster > Raster to 

Polygon со следующими параметрами.  

Переименуйте полученный слой в «Водосборные бассейны» и измените его символ на 

тонкую красную линию без заливки.  

Оформление итоговой карты. Установите масштаб карты равным 1:500 000. Переключитесь 

в режим компоновки. Измените ориентировку листа на альбомную.  Добавьте на карту численный 

масштаб и заголовок «Водотоки разных порядоков и их водосборные бассейны».  Добавьте 

легенду со следующими слоями: Водотоки, Водосборные бассейны и Послойная окраска. 

Добавьте пометку «Для каждого бассейна указана средняя высота в метрах над уровнем моря» 

Результат выполнения задания:  

1. Экспортируйте карту из режима компоновки в формат PNG с разрешением 300 

точек на дюйм с помощью команды File > Export Map. Сохраните его в свою директорию. 

2. Вставьте карту в отчетный файл. 

 

Лабораторная работа № 5.  

Привязка и цифрование гидрогеологической карты. 

Цель задания: знакомство с привязкой, трансформированием и цифрованием 

геоизображений, элементами базовых технологий ГИС (оверлей, пространственные запросы). 

Порядок выполнения задания: 

Откройте приложение ArcMap, создайте новый документ карты и сохраните его в свою 

папку Ex. Подключитесь в окне каталога к папке Ex. Убедитесь, что в ней находится база 

геоданных Don.gdb и растровый файл DonArtesian.png. Раскройте базу геоданных и перенесите на 

карту классы Lakes и Rivers.  Присвойте слою Lakes символ с голубой заливкой и синей обводкой. 

Настройте оформление слоя Rivers.  

Включите опцию подписи рек. Перейдите на вкладу Labels и отметьте флажок Label 

features in this layer. Выберите поле Название в качестве поля для подписей, смените их цвет на 

темно-синий и установите криволинейное размещение вдоль линии. Нажмите ОК. В результате 

операции все реки будут подписаны. 

Чтобы были подписаны только крупнейшие реки, необходимо использовать определяющий 

запрос на языке SQL. Для этого откройте снова свойства слоя и на вкладке Labels выберите метод 

«Define classes of features and label each class separately». 

Добавьте на карту из базы данных слой DonArtesian.png и поместите его непосредственно 

под слоем Rivers. При добавлении слоя появится диалоговое окно, предупреждающее о том, что 

файл не имеет привязки. Закройте его. Поместите карту в центр окна ArcMap. 

Откройте панель инструментов Georeferencing. Убедитесь, что в ее списке выбран файл 

DonArtesian. Выберите в ее меню команду Fit to Display, чтобы переместить непривязанный растр 

на середину области отображения. Поместите растр непосредственно под слоем Rivers. 

Используя инструмент расстановки контрольных точек, укажите пять контрольных точек в 

разных частях карты. Желательно, чтобы точки были равномерно распределены по полю карты 

(по краям и в центре) и не располагались на одной линии — это обеспечит хорошие 

коэффициенты трансформации. В качестве точек используйте места впадения притоков и 

впадения рек в водохранилища. 

Ознакомьтесь с доступными методами трансформирования по контрольным точкам. Для 

этого в меню Georeferencing выберите команду Transformation. По умолчанию выбрано аффинное 

преобразование. 

Осуществите трансформирование растра. На панели инструментов Georeferencing выберите 

команду меню Georeferencing > Update Georeferencing. Контрольные точки удалятся. 

Сохраните документ карты в формате mxd в папке отчета. 

Добавьте на карту слои Boundaries (границы) и Cities (города). Используйте для их 

отображения способ Categories и настройте отображение разными символами классов границ, а 

также городов в соответствии с численностью населения. При оформлении подписей городов 

используйте метод классифицированных подписей (прочтите соответствующий раздел в файле 

Описание функций). 
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Переключитесь в режим компоновки и оформите легенду карты. Добавьте название 

«Гидрогеологическое районирование среднего течения Дона», а также масштаб и свои ФИО. 

Экспортируйте результирующую карту в файл в формате PNG и вставьте ее в отчет. 

Результат выполнения задания:   

1. Экспортируйте карту из режима компоновки в формат PNG с разрешением 300 

точек на дюйм с помощью команды File > Export Map. Сохраните его в свою директорию. 

2. Вставьте карту в отчетный файл. 

 

Лабораторная работа № 6. 

Пространственная интерполяция характеристик годового стока с использованием ГИС-

технологий.  

Цель задания: построить региональные карты модуля годового стока и коэффициента 

вариации.  

Порядок выполнения задания: 

Подготовка данных. Создать новый XLSX-файл, в котором на отдельном рабочем листе для 

каждого из гидрологических постов сформировать ряд среднегодовых расходов воды.  

Импорт данных. Создать ГИС-проект с пространственной привязкой и добавить в него 

растровый файл с привязанной топографической картой и имеющиеся тематические шейп-файлы, 

в частности русловой сети и озер.  Добавить в окно содержания созданный по гидрологическим 

постам XLSX-файл. 

Построение интерполяционных карт. Создать новый полигональный шейп-файл и очертить 

в нем полигон, в границах которого будет производиться интерполяция. Построить кату изолиний 

среднемноголетнего модуля годового стока.  

Результат выполнения задания:   

Составить пояснительную записку  и оформить задание в соответствии с требованиями, 

включив в него таблицу рассчитанных данных по гидрологическим постам, основные карты и 

сведения по их точности, график региональной зависимости, описание алгоритмов расчетов и 

построений.  

 

Лабораторная работа № 7.  

Расчет характеристик годового стока на основе интерполяционных карт.  

Цель задания: определить параметры кривой обеспеченности годового стока, коэффициента 

вариации и рассчитать для неизученного водосбора среднегодовые расходы воды обеспеченности 

10,50 и 90 %.  

Порядок выполнения задания: 

Подготовка ГИС-проекта  - выделение исследуемого водосбора.  

Определение среднемноголетней величины годового стока и коэффициента вариации. 

Выполнить расчет с помощью осреднения значений узлов грида (сетки): создать новый 

полигональный шейп-файл, внутри которого оцифровать границы исследуемого водосбора – 

обрезать по созданному шейп-файлу с границами водосбора растровые карты модуля стока и 

коэффициента вариации.  

Результат выполнения задания:  Завершение расчетов, анализ полученных результатов и 

оформление задания проводятся в соответствии с рекомендациями. 

 

Критерии  оценки  работ 1 модуля 

Модуль 1. Практическое задание оценивается в 5 баллов за 1 задание. Всего 3 задания.  

Критерии оценки (в баллах) в соответствии рейтинг плану по максимальному и 

минимальному  количеству баллов: 

5 балла выставляется студенту, если продемонстрировал умение применять теоретические 

знания при выполнении практических заданий. Лабораторная работа выполнена полностью без 

неточностей и ошибок. 

4 балла выставляется студенту, если при выполнении лабораторной работы допущены 

несущественные ошибки. 
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3 балла выставляется студенту, если при выполнении лабораторной работы заметны 

пробелы в теоретических знании. Студент не полностью выполнил задание или при решении 

допущены значительные ошибки. 

2 балл выставляется студенту, если при выполнении лабораторной работы студент не 

полностью выполнил задание.  

1 балл выставляется студенту, если при выполнении лабораторной работы студент не 

полностью выполнил задание и при решении допущены грубые ошибки.  

 

Критерии  оценки  работ 2 модуля  

Модуль 2. Практическое задание оценивается в 6 баллов за 1 задание. Всего 3 задания.  

Критерии оценки (в баллах) в соответствии рейтинг плану по максимальному и 

минимальному  количеству баллов: 

6 баллов  - выставляется студенту, если при выполнении практической работы студент не 

полностью выполнил задание или при решении допущены 1 значительная ошибка. 

5 баллов - выставляется студенту, если при выполнении практической работы допущены 2 

несущественные ошибки. 

4 балла - выставляется студенту, если при выполнении практической работы допущены  3 

несущественные ошибки. 

3 балла - выставляется студенту, если при выполнении практической работы студент не 

полностью выполнил задание или при решении допущены 3 значительные ошибки. 

2 балла - выставляется студенту, если при выполнении практической работы студент не 

полностью выполнил задание и при решении допущены 1 грубая ошибка. 

1 балл - выставляется студенту, если при выполнении практической работы студент не 

полностью выполнил задание и при решении допущены 2 грубые ошибки. 

 

Практическое задание оценивается в 7 баллов за 1 задание. Всего 1 задание.  

Критерии оценки (в баллах) в соответствии рейтинг плану по максимальному и 

минимальному  количеству баллов: 

7 баллов  - выставляется студенту, если при выполнении практической работы студент не 

полностью выполнил задание или при решении допущены 1 значительная ошибка. 

6 баллов - выставляется студенту, если при выполнении практической работы допущены 2 

несущественные ошибки. 

5 баллов - выставляется студенту, если при выполнении практической работы студент не 

полностью выполнил задание или при решении допущены 2 значительные ошибки. 

4 балла - выставляется студенту, если при выполнении практической работы допущены  3 

несущественные ошибки. 

3 балла - выставляется студенту, если при выполнении практической работы студент не 

полностью выполнил задание или при решении допущены 3 значительные ошибки. 

2 балла - выставляется студенту, если при выполнении практической работы студент не 

полностью выполнил задание и при решении допущены 1 грубая ошибка. 

1 балл - выставляется студенту, если при выполнении практической работы студент не 

полностью выполнил задание и при решении допущены 2 грубые ошибки. 

 

Типовые задания для контрольной работы 

Описание контрольной работы: Письменная контрольная работа направлена на оценивание 

усвоения ЗУН, направлена на оценивание теоретических знаний по дисциплине. Контрольная 

работа в 1 варианте, в каждом варианте по 5 вопросов. Каждый ответ на вопрос оценивается в 3 

балла, согласно рейтинг-плану. 

 

Перечень вопросов для подготовки к контрольной работе по Модулю 1 

1. Оптимизация гидрометеорологических ИС.  

2. Критерии качества: простота вычислительного алгоритма, минимальная стоимость затрат на 

проведение натуральных экспериментов и т.д.  

3. Средства доступа к гидрометеорологическим базам данных.  
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4. Работа с гидрометеорологическими данными при помощи приложений: «сервера», 

представляющего данные из общей базы данных, и «клиента», запрашивающего данные у 

«сервера». 

5. Приложение «сервер»: режимы функционирования, структура размещения ресурсов, настройки 

«сервера», форматы системных журналов, взаимосвязь между настройками «сервера» и 

настройками ядра операционной системы, организация корпоративных данных из БД. 

6. Приложение «клиент»: одновременный доступ к нескольким серверам, одновременный доступ 

внутри одного «сервера» к нескольким базам данных. 

7. Особенности гидрометеорологических ИС для Интернет.  

8. Возможности, предоставляемые пользователям ГИС для Интернет. 

9. Проблемы безопасности в гидрометеорологических ИС. Контроль прав доступа. Контроль 

регистрационных журналов. Фильтрация пакетов. Резервное копирование и восстановление 

данных. Шифрование данных. 

10. Обзор современных гидрометеорологических информационных систем. Основные 

компоненты. Приложения. Телекоммуникация. Основные принципы работы. Региональные 

гидрометеорологические ИС. 

11. Определение морфометрических, ландшафтных и гидрографических характеристик речного 

водосбора в ArcMap. 

12. Основы работы с пространственными данными (визуализация). Создание климатической 

карты мира в ArcMap. 

13. Какие типы геометрии допустимы для слоев в базе геоданных? К каким типам относятся слои, 

использованные вами в работе? 

14. В какой системе координат хранились данные, которые вы использовали для составления 

карты? 

15. Какая проекция была использована вами в работе? К какому типу по характеру искажений она 

относится? 

16. Где хранятся данные, которые используются для классификации символов при отображении, 

изменения их размера и направления? 

17. За что отвечают системные поля Shape и ObjectID? 

 

Перечень вопросов для подготовки к контрольной работе по Модулю 2 

1. Чем отличается вид компоновки от вида данных? 

2. Анализ гидрографических сетей в ArcMap. 

3. Каким требованиям должны отвечать гидрографические данные, чтобы их можно было 

представить в виде геометрической сети? 

4. Какие функции выполняют флаги и барьеры при решении задач сетевого анализа? 

5. Какие задачи можно решать с помощью анализа геометрических сетей? 

6. Какие преимущества при редактировании данных дает топологическая структура данных? 

7. Анализ цифровой модели рельефа в ArcMap. 

8. Что представляет растр направления тока? 

9. Что представляет собой растр аккумуляции тока? 

10. Как можно выделить водотоки по растру аккумуляции тока? 

11. Как получаются порядки рек методом Стралера? 

12. После того как выделены водотоки, какую последовательность действий нужно выполнить, 

чтобы построить для них границы бассейнов? 

13. Как можно рассчитать статистику по бассейнам? Опишите последовательность действий. 

14. Привязка и цифрование гидрогеологической карты в ArcMap. 

15. В какой последовательности расставляются контрольные точки при привязке данных? Каково 

их оптимальное расположение? 

16. Какой метод трансформирования изображения вы использовали в работе? В чем его суть? 

17. Как пристыковать один полигон к другому, не оцифровывая их общую границу? Опишите 

последовательность действий. 

18. Что позволяют делать атрибутивная и пространственная выборки? (дополнительно) 
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19. В чем суть операции оверлея слоев? Чем эта операция отличается от пространственной 

выборки? (дополнительно) 

20. Пространственная интерполяция характеристик годового стока с использованием ГИС-

технологий в ArcMap. 

21. Расчет характеристик годового стока на основе интерполяционных в ArcMap. 

 

Пример варианта контрольной работы 

Модуль 1. 

Вопросы текущего контроля. Модуль 1. 

1. Какие типы геометрии допустимы для слоев в базе геоданных?  

2. Где хранятся данные, которые используются для классификации символов при отображении, 

изменения их размера и направления? 

3. За что отвечают системные поля Shape и ObjectID? 

4. Каким требованиям должны отвечать гидрографические данные, чтобы их можно было 

представить в виде геометрической сети? 

5. Какие функции выполняют флаги и барьеры при решении задач сетевого анализа?  

 
Модуль 2. 

Вопросы текущего контроля. Модуль 2. 

1. Что представляет растр направления тока? Что представляет собой растр аккумуляции тока? 

2. Как можно выделить водотоки по растру аккумуляции тока? 

3. Как получаются порядки рек методом Стралера? 

4. После того как выделены водотоки, какую последовательность действий нужно выполнить, 

чтобы построить для них границы бассейнов? 

5. В какой последовательности расставляются контрольные точки при привязке данных? Каково 

их оптимальное расположение? 

 

Критерии оценки (в баллах): 

15 баллов выставляется студенту, если студент дал полные, развернутые ответы на все 

теоретические вопросы. 

от 10 до 15 баллов выставляется студенту, если студент дал полные, развернутые ответы на 

несколько вопросов, однако допущены неточности в ответах на 1, 2 вопроса. 

от 5 до 10 баллов выставляется студенту, если студент дал полные, развернутые ответы на 

пару вопросов, однако допущены неточности в ответах на остальные вопросы. 

от 0 до 5 баллов выставляется студенту, если ответ на теоретические вопросы 

свидетельствует о непонимании и крайне неполном знании основных понятий и методов.  
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5. Учебно-методическое и информационное обеспечение дисциплины 

5.1. Перечень основной и дополнительной учебной литературы, необходимой для освоения 

дисциплины 

Основная литература: 

1. Геоинформационные системы: учебное пособие/ Ловцов Д.А., Черных А.М. – М.: 

Российская академия правосудия, 2012. – 191 с. http://biblioclub.ru/index.php?page=book&id=140619 

 

Дополнительная литература: 

2. Географические информационные системы: методические указания / ФГБОУ ВПО 

«Нижегородский государственный архитектурно-строительный университет», Кафедра 

иностранных языков ; сост. Н.Г. Надеждина. - Нижний Новгород: ННГАСУ, 2014. - 45 с. 

http://biblioclub.ru/index.php?page=book&id=427431 

3. Геоинформационные системы и дистанционное зондирование: учебное пособие / К.В. 

Шошина, Р.А. Алешко ; Министерство образования и науки Российской Федерации, Федеральное 

государственное автономное образовательное учреждение высшего профессионального 

образования Северный (Арктический) федеральный университет им. М.В. Ломоносова. - 

Архангельск : ИД САФУ, 2014. - Ч. 1. - 76 с. http://biblioclub.ru/index.php?page=book&id=312310 

4. Картография с основами топографии : учебник / Л. А. Фокина.— М. : ВЛАДОС, 2005 .— 

335 с. Абонемент № 3 (4 экземпляра); Абонемент № 8 (55 экземпляров).  

5. Коноплева, И.А. Информационные технологии: учебное пособие / И.А. Коноплева, О.А. 

Хохлова, А.В. Денисов; под ред. И.А. Коноплевой. - 2-е изд., перераб. и доп. - Москва : Проспект, 

2014. - 328 с. http://biblioclub.ru/index.php?page=book&id=251652 

6. Трифонова, Т.А. Почвенно-продукционный потенциал экосистем речных бассейнов на 

основе наземных и дистанционных данных / Т.А. Трифонова, Н.В. Мищенко. - Москва: 

Издательство ГЕОС, 2013. - 271 с. http://biblioclub.ru/index.php?page=book&id=469028 

 

5.2.Перечень ресурсов информационно-телекоммуникационной сети «Интернет» и 

программного обеспечения, необходимых для освоения дисциплин 
1. Электронная библиотечная система «ЭБ БашГУ» - https://elib.bashedu.ru // 

2. Электронная библиотечная система издательства «Лань» - https://e.lanbook.com / 

3. Электронная библиотечная система «Университетская библиотека онлайн» -   

https://biblioclub.ru/ 

4. Научная электронная библиотека - elibrary.ru  (доступ к электронным научным 

журналам) -  https://elibrary.ru/projects/subscription/rus_titles_open.asp 

5. Электронный каталог Библиотеки БашГУ -  http://www.bashlib.ru/catalogi/    

6. Электронная библиотека диссертаций РГБ - http://diss.rsl.ru / 

7. Государственная публичная научно-техническая библиотека России. База данных 

международных индексов научного цитирования SCOPUS - http://www.gpntb.ru 

8. Государственная публичная научно-техническая библиотека России. База данных 

международных индексов научного цитирования WebofScience  - http://www.gpntb.ru 

 

Программное обеспечение: 

1. Windows 8 Russian. Windows Professional 8 Russian Upgrade. Договор №104 от 17.06.2013 

г. Лицензии бессрочные. 

2. Microsoft Office Standard 2013 Russian. Договор №114 от 12.11.2014 г. Лицензии 

бессрочные. 

3. ArcGIS 10.1 for DesktopAdvanced (Arclnfo) LabPak. Договор №263 от 07.12.2012 г. 

Лицензии бессрочные. 

 

 

http://biblioclub.ru/index.php?page=book&id=140619
http://biblioclub.ru/index.php?page=book&id=427431
http://biblioclub.ru/index.php?page=book&id=312310
http://biblioclub.ru/index.php?page=book&id=251652
http://biblioclub.ru/index.php?page=book&id=469028
https://biblioclub.ru/
https://elibrary.ru/projects/subscription/rus_titles_open.asp
http://www.bashlib.ru/catalogi/
file:///D:/Работа%20Лилия/РПД%20МАГ%20ГМ/%20http:/diss.rsl.ru%20/
http://www.gpntb.ru/
http://www.gpntb.ru/
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6.Материально-техническая база, необходимая для осуществления образовательного 

процесса по дисциплине 

Наименование специальных* 

помещений и помещений для 

самостоятельной работы 

Оснащенность  специальных помещений и 

помещений для самостоятельной работы 

Перечень лицензионного 

программного 

обеспечения. 

Реквизиты 

подтверждающего 

документа 

1. учебная аудитория для 

проведения занятий 

лекционного типа: аудитория № 

711 (гуманитарный корпус), 

аудитория № 809И (гуманитарный 

корпус). 

2. учебная аудитория для 

проведения лабораторных 

работ: аудитория № 707И 

Лаборатория ИТ (компьютерный 

класс) (гуманитарный корпус), 

аудитория № 709И Лаборатория 

ИТ (компьютерный класс) 

(гуманитарный корпус). 

3. учебная аудитория для 

проведения групповых и 

индивидуальных консультаций:  
аудитория № 707И Лаборатория 

ИТ (компьютерный класс) 

(гуманитарный корпус), аудитория 

№ 709И Лаборатория ИТ 

(компьютерный класс) 

(гуманитарный корпус), аудитория 

№ 704    (гуманитарный корпус), 

аудитория № 708И Лаборатория 

ИТ (компьютерный класс) 

(гуманитарный корпус) 

4. учебная аудитория для 

текущего контроля и 

промежуточной аттестации: 
лаборатория (компьютерный 

класс) № 707И (гуманитарный 

корпус), лаборатория 

(компьютерный класс) № 709И 

(гуманитарный корпус), аудитория 

№ 704    (гуманитарный корпус), 

аудитория № 708И Лаборатория 

ИТ (компьютерный класс) 

(гуманитарный корпус) 

5. помещения для 

самостоятельной работы: 

аудитория № 704/1 (гуманитарный 

корпус); абонемент №8 

(читальный зал) (ауд. 815И) 

(гуманитарный корпус) 

6. помещения для хранения и 

профилактического 

обслуживания учебного 

оборудования:  № 820И 

(гуманитарный корпус). 

Аудитория № 711 

Учебная мебель, доска, мультимедийный проектор 

BenQMX511(DLP.XGA.2700 ANSI.High Contrast 

Ratio 3000, ноутбук Lenovo Idea Pad B 570 15.6» 

Inte Corei 32350M 4Gb, экран на штативе Screen 

Media Apollo формат 183*244см   

Аудитория № 809И 

Учебная мебель, доска, мультимедийный проектор 

BenQMX511(DLP.XGA.2700 ANSI.High Contrast 

Ratio 3000, ноутбук Lenovo Idea Pad B 570 15.6» 

Inte Corei 32350M 4Gb, экран на штативе Screen 

Media Apollo формат 183*244см   

Аудитория № 707И 

Лаборатория ИТ (компьютерный класс) 

Учебная мебель, доска, персональный компьютер в 

комплекте процессор Intel Celeron G1840 2.8 GHz, 

HDD 500 Gb, DDR302Gb+монитор Samsung SE200 

Series (13шт.) 

Аудитория № 709И 

Лаборатория ИТ (компьютерный класс) 

Учебная мебель, доска, персональные компьютеры 

в комплекте № 1 iRUCorp 510 (13 шт.). 

Аудитория № 708И 

Лаборатория ИТ (компьютерный класс) 

Учебная мебель, доска, компьютеры в составе 

DepoNeos 470Md: системный блок 3450/4Gddr 

1333/n 500G/DyD+RY, мониторы 20 (13 шт.) 

Аудитория № 704 

Учебная мебель, доска, мультимедийный проектор 

BenQMX511(DLP.XGA.2700 ANSI.High Contrast 

Ratio 3000, ноутбук Lenovo Idea Pad B 570 15.6» 

Inte Corei 32350M 4Gb, экран на штативе Screen 

Media Apollo формат 183*244см   

Аудитория № 704/1 

Учебная мебель, доска, персональные компьютеры: 

процессор Thermaltake Intel Core 2 Duo, монитор 

Acer AL1916W, Window Vista, монитор 19" LG 

L1919S BF Black (LCD<TFT, 8ms, 1280×1024, 250 

кд/м, 1400:1,4:3 D-Sub), процессор InWin, Intel Core 

2 Duo, монитор Flatron 700, процессор «Кламас», 

монитор Samsung MJ17 ASKN /EDC, процессор 

«Intel Inside Pentium 4», мышь и клавиатура. 

Абонемент №8 (читальный зал)  

Учебная мебель, компьютеры в сборе (системный 

блок Powercool\Ryzen 3 2200G (3.5)\ 8Gb\ A320M 

\HDD 1Tb\ DVD-RW\450W\ Win10 Pro\ Кл-раUSB\ 

МышьUSB\ LCDМонитор 21,5"- 3 шт.) 

Помещение № 820И 

Учебно-наглядные пособия, мультимедийный 

проектор BenQ MX511 DLP XGA 2700 ANSI High 

Contrast Ratio 3000, ноутбук Lenovo Idea Pad B570 

15.6 Intel Corei 32350M 4Gb, экран на штативе 

Screen Media Apollo - 183×244см 

1. Windows 8 Russian. 

Windows Professional 8 

Russian Upgrade. Договор 

№104 от 17.06.2013 г. 

Лицензии бессрочные. 

2. Microsoft Office 

Standard 2013 Russian. 

Договор №114 от 

12.11.2014 г. Лицензии 

бессрочные. 

3. ArcGIS 10.1 for 

DesktopAdvanced (Arclnfo) 

LabPak. Договор №263 от 

07.12.2012 г. Лицензии 

бессрочные. 

 

 


